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1. General information 

LookSky – is a new cross-platform version of the frames viewer of the Lemur 

software for automated satellites, asteroids and comets discoveries in a series of CCD-

frames.  

 

The main features of LookSky are the following: 

• visual analysis of the moving objects (satellites, asteroids and comets) 

detected in automation mode by Lemur software; 

• deleting the false objects (it is necessary to pay attention to the previously 

unknown objects); 

• hand measuring of the objects (satellites, asteroids and comets) that were 

not detected in automation mode;  

• tuning visualization parameters (brightness, contrast, palette...); 

• work with the list of processed series, generate a report for the entire list of 

series; 

• creation and sending the reports. 

 

After the successful processing of a series of frames by Lemur software perform 

start of LookSky. To do this, launch the executable file accordingly to the operating 

system: «LookSky.exe» (Windows) or «LookSky» (Linux). 

 

2. Loading data 

By uploading data we mean uploading a series (or several series) of processed 

frames. In this case, it is necessary to select the folder with the processed frames, inside 

such folder all the meta-data with the result of processing (directories of moving 

objects, configuration file, etc.) should be located.  

It is also possible to load individual frames (which have not been processed), but 

the main functions of the program will not be available. 
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2.1. Initial user settings 

During the first launching of LookSky (figure 1) perform the initial user 

settings. For this open LookSky settings by menu «File → Profile LookSky». The 

following settings are available: localization settings, saving of the parameters and 

windows position, automated objects searching and loading from the active series. 

 
Figure 1. LookSky during the first launching 

2.2. Series loading 

After initial user settings load the series of frames processed by Lemur software 

using menu «File → Open series…», or use the "Open Series..." button in the "Manager 

of survey" window. If you select the "Open series (recursive search...)" button - it will 

be possible to open all the series that will be located inside the specified folder. In the 

appeared dialog window find and select the folder with the processed series of frames. 

The loading process may take several seconds.  
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Figure 2. LookSky open series 

 

After loading the series of frames the activation window will appear (figure 3).  

 

 
Figure 3. Activation window 

 

Select «Yes» button for the frame activation from loaded series.   
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3. Main windows 

3.1. Main windows 

After loading one or more series, the appearance of the program may look as 

shown in Figure 4. There are three main windows in the program:  

Manager of Survey - the window for displaying and managing the list of loaded 

series. 

Image view - the window for displaying frames, setting visualization parameters, 

centering frames by stars, etc. 

Manager of Objects - the window for displaying the space objects (satellites, 

asteroids (comets)), which were found during processing, and the objects loaded from 

the catalog of the minor planets center and the tle-catalog of the satellites. 

You can set position and size of all windows in the program according to the used 

monitor to increase usability (figure 4). 

More details below. 

 

 

Figure 4. Main windows 
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3.2. Manager of Survey 

Marker "1" - select the folder with the processed frames. You can select only one 

series (Open series...), or select to open several series (Open series (recursive 

search)...). 

Marker "2" update the series in the list. This function can be useful when new 

frames appear in the folder, or to cancel changes made by the user in the list of objects. 

Marker "3" close the series.  

Marker "4" - sign of the active series, pay attention to the "!" sign.  

Marker "5" - area of the window, in which you need to click the left mouse button, 

in order to go to this series.  

Marker "6" - open (add a frame).  

Marker "7" - frame update.  

Marker "8" - close the frame.  

Marker "9" - is the sign of the active frame, which is currently displayed. 

 
Figure 5. Manager of Survey 
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3.3. Image view 

This window is for displaying frames. It contains the control buttons described 

below (see figure 6): 
 

Marker "1" - is a button to turn on the frames centering by stars. It is 

recommended to turn on the "centering" mode when viewing slow objects captured in 

diurnal tracking mode, e.g. asteroids/comets. When viewing fast objects, for example 

satellites, it is recommended to turn off this mode. 

Marker "2" - enable/disable all displayed information. 

Marker "3" - rewind frame by frame. 

Marker "4" - blinking all frames of the series. Next to the button there is a drop-

down menu where you can select the blinking time and the ability to rewind frames 

with the right and left mouse buttons (try it, it is convenient). 

Marker "5" - control the frame display scale. Next to the button, there is a drop-

down menu, where you can select the scale of 100% and "fit into the screen". 

Marker "6" - save images in bmp or gif formats. 

Marker "7" - adjusting the display parameters - brightness, contrast, palette... 

Marker "8" - set the orientation of the axes of the displayed frames. 

Marker "9" - activate the magnifier. 

Marker "10" - opening the information panel of pixel coordinates. 

Marker "11" - opening the panel of the displayed area of the frame. It may be 

convenient when working with very large frames. 

Marker "12" - opening the window for manual measurement of angular 

coordinates and magnitude of objects on the frames of the series. More details about 

this function will be described in a separate section. 
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Figure 6. Image view 
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3.4. Manager of Objects.  

After successful series loading and activation the list of detected moving objects 

(satellites, asteroids or comets) will appear in «Manager Objects» window. 

 

There are four lists of space objects available in the program (see figure 7): 

Asteroids - Data of CoLiTec - a list of asteroids (comets) which were detected by the 

program during frames processing. This list can contain both real objects (which can 

be identified with MPC catalog, or not if they are new objects) and false detections. 

 

Asteroids - Data of Minor Planet Center - list of asteroids (comets) that were 

downloaded online from MPC service. 

 

Satellites - Data of CoLiTec - the list of satellites, which were detected by the program 

during frames processing. This list can contain both real objects and false detections. 

 

Satellites - Data of SSA Catalog - the list of satellites that were written to the 

configuration file by the observer before the processing. See the 

Lemur.ConfigManager manual for details on how to load the catalog of satellites into 

the configuration file. 
 

 
 

Figure 7. Selecting a list of space objects 
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Manager of Objects – features. 

 

The Manager of Objects window has a set of functions that help the observer to 

select, analyze the result of the automatic search for objects and generate reports with 

measurements. 

 

The functions are described below (see figure 8): 

Marker "1" - selection of the list of space objects. 

Marker "2" - button to enable/disable the display of data on objects on the frame. 

Marker "3" - data update. 

Marker "4" - saving the results of editing the list of found objects. By pressing 

this button, the state of the enabled/disabled checkboxes next to each object in the list 

is saved. Generally, switched off checkbox means that this object is false (or you just 

have to disable its display, so it won't interfere with viewing of other, close objects). 

Keep in mind that a report with measurements will not be generated for the object next 

to which the checkbox is disabled. 

Marker "5" - start the window of manual measuring of angular coordinates and 

magnitude of the object.  

Marker "6" - list clearing. 

Marker "7" - call the dialog box of report formation - only by selected object. 

Marker "8" - call the dialog box of report forming for all objects in the list, 

opposite to which the checkbox is enabled. 

Marker "9" - enabling/disabling the display of objects on the frames. 

Marker "10" - enable/disable the display of "yellow" strobes - the area of objects 

movement. 

Marker "11" - enable/disable the display of the object marker. 

Marker "12" - enable/disable the display of the object number. 

Marker "13" - setting parameters when navigating between objects. Scale - to 

scale the frame when selecting an object in the list. Nearest frame - switch to display 

the nearest frame, which has a measurement for the selected object. 

Marker "14" - open the text file with objects. 

Marker "15" - checkbox to enable/disable the display of the object. Keep in mind 

that the report with measurements will not be generated for the object next to which 

the checkbox is disabled. 

Marker "16" - an example of identification and non-identification of the object 

with the catalog. 

Marker "17" - header of the displayed parameters. By clicking the right mouse 

button you can select the desired set of columns. 
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Figure 8. Manager of Objects features 

 

4. Visual analysis of found moving objects 

 

This visual analysis of found moving objects is necessary to select real objects 

from false detections.  

To perform visual analysis, depending on the processing (asteroids or satellites), 

select the required list of objects in the Manager of Objects window - "Asteriods - Data 

of CoLiTec" or "Satellites - Data of CoLiTec".  

Then enable frame blinking (section "3.3 Image view", marker "4").  

Left-click on the object in the "Manager of Objects" window and the display area 

in the "Image view" window will move to the selected object. For your convenience, 

set the "Use a navigation on a frame" option (section "3.4 Manager of Objects", fig. 8, 

marker "13"). 

Use your eyes to judge, if the object is real or false. If the object is false, uncheck 

the box in the "Draw" column next to the object.  

Pass in this way through the whole list of found objects. 
 

  

Figure 9. Removing a false object 

 

You can also use data from the Minor Planet Center (MPC) catalog to control the 

quality of automatic detection of moving objects by the Lemur software. To do this, 
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select the tab "Asteroids - Data of Minor Planet Center" (Figure 7) and check each 

object that is in the catalog list. In the case of satellite frames processing, it is necessary 

to select the tab "Satellites - Data of SSA Catalog" (Figure 7) to control the quality of 

automatic detection. If any objects were not detected, the program has a function of 

manual measurement of objects. 

Figure 10 below shows the types of strobes displayed:  

Yellow rectangular strobe is an asteroid (comet) that was detected by the program 

in automatic mode (or by a manual measurer). The inscription next to the yellow strobe 

shows: the serial number of the object in the list, the internal designation of the object, 

the average value of the object's magnitude estimate. 

The red square is the display of the asteroid (comet) from the MPC catalog. The 

inscription near the red strobe shows: the serial number of the object in the list, the 

designation of the object in the MPC catalog, the catalog value of the object in the 

MPC catalog. 

Accordingly, if two strobes, yellow and red, are adjacent, it means that the program 

has found the known object in the MPC catalog (example "marker-1").  

If the object is in the MPC catalog, i.e. there is a red strobe, but there is no automatic 

detection (no yellow strobe), then, such object was not found. The reasons for this can 

be different - too weak object, the image of the object on many frames overlapped with 

the image of the stars, errors in the program... (example "marker-2"). 

Example "marker-3" - in this case shows false detection by the program, but be 

careful, in your case it can be a new object!  
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Figure 10. Description of displayed strobes 

 

5. Hand measuring of the objects 

 

In case if some objects (asteroids/comets or satellites) were not detected by 

Lemur software and there is only one red (MPC) selection of these objects you should 

perform the hand measuring of all not detected objects. To do this, use «Tools → Hand 

Measurer» menu. 
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The measuring of the object's image in the current frame can be perfomed by 

clicking on Ctrl+LMB. Measure the required object on each frame, you can do this by 

using the frame navigation buttons or by turning on the frame blink button. 

 

 
Figure 11. Hand measuring of the object 
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After getting all the measurements, click the " Make object " button, and this new 

object will be added to «Asteroids - Data of CoLiTec» list, or to the  «Satellites - Data 

of CoLiTec» list, depending on the type of the measured object (figure 12). 

 
Figure 12. Creating an object 
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The functions of the manual measurement window are described below. 

 

Marker "1" - selection of the type of object to be measured (asteroid/satellite). 

Marker "2" - add the object to the list for measurement. 

Marker "3" - delete the object from the measurement list. 

Marker "4" - make an object. 

Marker "5" - add a measurement of the object. 

Marker "6" - delete the measurement of the object. 

Marker "7" - activation of mode Gn - auto tracking on "one frame" - it means that the 

search of the image of the object on the next frame will be made relative to the 

coordinates obtained on the current frame. It is advisable to turn on this mode when 

measuring satellites that were tracked by the telescope.  

Marker "8" - switching on mode Gg - auto tracking on "two frames" - this means that 

the search for an object image on the next frame will be made relative to the coordinates 

obtained on the two previous frames. 

Marker "9" - enabling the notification of measurement errors. 

Marker "10" - switching on the display of measurements. 

Marker "11" - activation of navigation, frame centering relative to the object. 

Marker "12" - search radius relative to the predicted coordinates (used in Gn and Gg 

modes). 

Marker "13" - minimum OSR value of the object. 

Marker "14" - smoothing coefficient (used in Gg modes). 

 

 
Figure 13. Manual measurement window functions 
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6. Forming a report 

Create report after saving the results of work (figure 14). 
 

 

Figure 14. Report window opening 

 

IMPORTANT! To send reports from LookSky set E-mail settings in «Report/E-

mail settings→ Sender settings» section and check fields in «MPC recipient» section 

in the settings editor Lemur Config Manager. Report also can be saved as text file 

and sent manually from the preferred mail service. 

If several series were downloaded, LookSky provides the opportunity to generate 

a consolidated report for several series (figure 15). 

 

 

Figure 15. Report creation for sending 
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